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Introduction

Using Microsoft Excel Spreadsheets is one of a valuable
and user-friendly new series of easy-to-read booklets
created specially to help you develop at work. The
materials have been created from actual experience in
the workplace. Experts from Workbase Training and
Campaign for Learning have pooled their knowledge
and experience to involve you in learning new skills and
building on those you already have. The booklet is
divided into clear sections, containing specially devised
activities. There are also exercises at the end of the
sections to allow you to practise as you learn.
Before you begin using this booklet, it is assumed that:

• you will have already received an introduction to the
computer
• you are familiar with the keyboard
• you can use a mouse to point, click, double-click and drag
• you are using Windows software.

Information
and skills you
will acquire

Using Microsoft Excel Spreadsheets will enable you to:
Understand what a spreadsheet is and become
familiar with the layout of a spreadsheet screen.
Create a new spreadsheet , make corrections,
save, close, open and print.
Change the look of a spreadsheet.

Perform calculations in a spreadsheet.

Getting the
most out of
this booklet

You may want to work your way through the booklet
from start to finish or focus on an area of interest.
Once you have completed the questionnaire on
page 4 you will be able to see clearly which topics
you need most help with, and which areas you can
safely leave out.
You may want to ask your supervisor or another
colleague for their views on the areas you could work
on, or for help with the activities in the booklet.
As you may want to use the booklet for future
reference, you may want to write the answers out
in rough first and then write them in the booklet.

USING MICROSOFT EXCEL SPREADSHEETS. LEARNING FOR WORK Series. © Workbase Training
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Questionnaire
What do you
need most
help with?

This questionnaire is to enable you to think about which
areas of spreadsheet skills you need most help with.
Tick boxes as appropriate.

1

2

3

I need a
lot of help.

I need
some help.

I can cope.

SECTION 1: What spreadsheets
can be used for
SECTION 2: Understanding the
layout of a spreadsheet screen
SECTION 3: Creating a new
spreadsheet
Making corrections to
a spreadsheet
SECTION 4: Changing the
appearance of a spreadsheet
Changing the way a spreadsheet
is laid out on a page
SECTION 5: Performing
calculations in a spreadsheet
SECTION 6: Opening a
spreadsheet created earlier
Saving a spreadsheet

Closing a spreadsheet

The most important areas for you to concentrate on
are those which you have marked 1 or 2.

Create your
own learning
plan
4

Use the questionnaire above to create your own
learning plan. You may wish to use a separate sheet of
paper.

USING MICROSOFT EXCEL SPREADSHEETS. LEARNING FOR WORK Series. © Workbase Training

Section1
What spreadsheets can be
used for

UNDERSTANDING
SPREADSHEETS
A spreadsheet is a large worksheet laid out in a grid format
and used for working with numbers (see fig. 1
Spreadsheet grid layout). Spreadsheets were designed to
make it easier for accountants to create accounts, and
managers to record and analyse figures. Rather than
writing information in a ledger book and performing
calculations with a calculator, information can be typed
into a spreadsheet using a computer.
There are many automatic features, like AutoSum for
adding a list of numbers, that make it easier to use
spreadsheets and work with numbers. A spreadsheet
can be used to create worksheets from a simple
personal budget to complex financial or even scientific
information. Numeric data in a spreadsheet can also be
presented in a graph format.
Spreadsheets are used for creating worksheets that you
would normally handwrite in a ledger. Examples of
what a spreadsheet can be used for are:

•
•
•
•

accounts
• invoices
salaries/wages
• sales/purchase lists
sales commission
• expenses lists
business/personal budgets

Using a spreadsheet program, you can process words
and numbers by typing, correcting, making changes
and performing calculations on the screen before
printing it out. Spreadsheet computer packages include
Microsoft Excel and Lotus 123.
Part of getting used to spreadsheets will be to understand
some of the words that describe features that you will
use. A list of terms has been included at the end of this
booklet to explain these words.
Using a computer to produce spreadsheets is easier if you
understand the different parts of the screen and what
they are used for. You may never use all the features and
functions but it is important to know the aspects you
will need and not be confused by the rest! Learning a
bit at a time is the best way to develop your skills when
using a computer spreadsheet package. Improvement
will come with practice.
USING MICROSOFT EXCEL SPREADSHEETS. LEARNING FOR WORK Series. © Workbase Training
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Section2

UNDERSTANDING THE LAYOUT
OF A SPREADSHEET SCREEN

What you may
see on the
screen

A spreadsheet is laid out in a grid format to make entering
numbers into columns easier (see fig. 1). A spreadsheet
page is very large and consists of over 200 columns and
over 16,000 rows. You cannot therefore see the whole
spreadsheet on the screen and you may not use all the
columns and rows in a worksheet. As the worksheet is
very large, column letters and row numbers are used to
help you to navigate around a spreadsheet and know
where you are on the large worksheet page.
Column Header Letter:
lets you know which column
you are working in or viewing
in the worksheet.

Name
box: lets you
know which
cell is
currently
active in the
worksheet.

Row
Header
number: lets
you know
which row
you are
working in or
viewing in
the
worksheet.

Cells

Fig. 1 Spreadsheet grid layout

Navigating
using cell
references

6

Active cell:
dark box around
a cell, e.g. D8 –
whatever you type
will appear in this
cell.
To move the active
cell to type elsewhere
in the grid, use the
mouse to point and
click where you want
to type next.

Each rectangular boxed area on the grid is called a cell.
The active cell is the cell with the dark box around it.
Whatever you type will appear in the active cell. You
can move the active cell to another cell in the grid by
pointing and clicking with the mouse wherever you
want to type data next, or by using the arrow keys on
the keyboard. Each cell has a unique reference that
makes it different from the next cell.

USING MICROSOFT EXCEL SPREADSHEETS. LEARNING FOR WORK Series. © Workbase Training

See also
booklet 17: Using Microsoft
Word for Wordprocessing.

Activity1

To identify which cell is active, look at which column
the active cell is in, e.g. column D. Then look to see
which row the active cell is in, e.g. row number 8. This
gives you the unique cell reference for the active cell,
which is cell D8. Being able to identify which cell you
are in assists you with navigating around a spreadsheet
and will also become important when you are working
with calculations, which will be covered in Section 5.

Define a spreadsheet package.
1. What is a spreadsheet?
a parcel of words
a large grid for working with numbers and words
a program for writing a book
2. List three things that you may use a spreadsheet
package for:

You will find the feedback to
this activity on page 30.

Activity2
You will find the feedback to
this activity on page 30.

Key
Learning
Points

1. Identify the following cell references on fig. 1 or
using your computer:
• E9
• F12
• A1
• B5
2. Which one of the following statements is true?
(a) The active cell is the whole worksheet on the screen.
(b) The active cell is where anything typed will appear.

Spreadsheets are used for creating worksheets that
include numbers and words. You can create accounts,
budgets, invoices, sales and purchase lists
Spreadsheets are laid out in a grid format to make
entering numbers easier. You can find your way
around a spreadsheet using the column and row
headings as a guide.
Understanding the different parts of the screen
makes it easier to use spreadsheets.
You do not need to know everything about spreadsheets – it is best to concentrate on a few areas that
you will use at the beginning and learn all about
them, before choosing to learn about other areas.

USING MICROSOFT EXCEL SPREADSHEETS. LEARNING FOR WORK Series. © Workbase Training
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Section3
Creating a
spreadsheet

CREATING AND MAKING
CHANGES TO A SPREADSHEET
Using spreadsheets enables you to create many different
types of worksheets – for example, invoices, budgets,
sales and purchase lists, numbers for analysis. Once it
has been created, you can easily make changes to the
worksheet without having to retype it.
Whenever you start your spreadsheet program, a new
blank worksheet appears ready for you to start typing.
What you type will appear in the active cell – the grid
with the dark box around it (see fig. 2). To start another
new worksheet, you can click on File menu option and
select New from the list. When typing, bear the
following points in mind:

• Enter text and numbers – typing will appear in the
active cell with the dark box around it.

• Move around grid – use the mouse to point and click
where you want the active cell positioned next or the
arrow keys on the keyboard to move from cell to cell.
• Data alignment – numbers are automatically aligned
with the right side of a cell so that numbers line up
correctly under each other. Text or words are aligned
with the left side of the cell.
• Undo – as soon as you make a mistake when typing,
you can use the Undo picture icon to cancel your very
last action.
Name
box: displays
the cell
reference of
the current
active cell.

Column Header letter: lets you
know where you are in the worksheet.

Active cell:
dark box around a
cell, e.g. E2 – whatever
you type will appear
in this cell.

Row
Header
number: lets
you know
where you
are in the
worksheet.

Numbers automatically
align to the right of a cell.

To move the active
cell to type elsewhere
in the grid, use the
mouse to point and
click where you
want to type.

Fig. 2 Spreadsheet grid layout

8
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Making
changes to a
spreadsheet

Spreadsheets make it easier to correct a worksheet
without having to retype it. When correcting a worksheet,
you will make use of the backspace and delete keys on
the keyboard. You will also use the mouse to move the
active cell from one part of the spreadsheet to another.

• If you make a mistake whilst typing in a cell, you can
use the backspace and delete keys to make
alterations – the backspace key deletes text on the
left-hand side of the flashing cursor. It moves
backwards through your text or numbers, deleting
one digit at a time. Position the cursor at the end of
the number or letter to be deleted and press the
backspace key.
• To delete text using the delete key, position the
cursor in front of the word or number to be deleted.
Press the delete key and one digit at a time will be
deleted from the right (see fig. 3).
Backspace key

Delete key
Delete

Fig. 3 Editing keys

• You can overwrite what is in a cell by simply making

•

•

•
See also
booklet 17: Using Microsoft
Word for Wordprocessing.

•

that cell active. Anything you type will replace what
was in the current active cell.
Take care when overwriting the contents of a cell,
make sure you don’t delete data that you wanted
to keep.
To make changes to a cell’s contents without
overwriting, double click with the mouse and the
cursor will appear flashing within the active cell. You
can then use the arrow keys to move the cursor
within the cell to the required position to add or
remove data.
To delete text or numbers, make the required cell
active and press the delete key on the keyboard to
clear the contents of that cell.
You can use the undo button on the toolbar
immediately if you make a mistake.

USING MICROSOFT EXCEL SPREADSHEETS. LEARNING FOR WORK Series. © Workbase Training
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Activity3

Creating a spreadsheet
1. Create the following sales spreadsheet.

2. Edit the spreadsheet by spelling out the months of
the year in full:
You will find the feedback to
this activity on page 30.

Key
Learning
Points

10

January – February – March

Using spreadsheets you can create many different
types of worksheets – for example, invoices,
budgets, sales and purchase lists, numbers for
analysis.
Once it has been created, you can easily make cor
rections to the worksheet without having to
retype it.

USING MICROSOFT EXCEL SPREADSHEETS. LEARNING FOR WORK Series. © Workbase Training

Section4

CHANGING THE APPEARANCE
OF A SPREADSHEET
Once you have created your spreadsheet and made any
corrections required, you can then move on to change the
appearance of the spreadsheet. You can achieve this by:
1. Formatting parts of the spreadsheet to change the
style and appearance of text or numbers. For example,
the spreadsheet column headings can be made bigger,
smaller or bolder to stand out, or aligned to the right
side of the cell to line up with the numbers. Numbers
can also be formatted to, for example, currency, which
automatically displays a £ sign before a selected number.
2. Resizing columns making them wider to fit long
words or numbers and narrower if the contents of
the cell are minimal.
3. Moving and copying information from one place on
the spreadsheet to another without the need to
retype the data.
4. Inserting or deleting columns and/or rows to add
more information or space in your spreadsheet.

Formatting
Working on text

Working on numbers

Applying formats to text
To change the look of the cell contents, e.g. to make
the headings bold, simply make the cell active where
you want bold to be applied and click once on the bold
toolbar icon. You could also use the italic and underline
toolbar buttons to make headings stand out. You can
also position the headings on the right side of the cell
to line up with the numbers (see fig. 5).
Applying a format style to numbers
You can also change the look or style of numbers to
represent the type of worksheet you are working on. If
you are working with money, you can apply a currency
style to numbers (see fig. 4). This places a £ sign in front
of a number without you having to type it. You can also
increase or decrease the number of decimal places of a
number. If working with money, numbers can be displayed to two decimal places.
To change the format of numbers, make the relevant
cell active and choose the number format required.

USING MICROSOFT EXCEL SPREADSHEETS. LEARNING FOR WORK Series. © Workbase Training
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Percentage – will display
number as a %, e.g. 0.5 to 50%

Increase decimal – will add
decimal places to selected number,
e.g. 45.1 to 45.10 or 45.100

Currency – numbers will
be displayed as pounds and
pence, e.g. £150.00

Comma – separates
thousands with a comma,
e.g. 12000 to 12,000

Decrease decimal –
will reduce decimal places
to selected number, e.g.
45.100 to 45.1

Fig. 4 Number formatting toolbar icons
More number format options can be chosen from the
Format menu. Selecting the Format Cells dialogue box
(see fig. 5) displays other types of number formats available
depending on the type of numbers you are working
with. As spreadsheets can be used to create simple and
complex worksheets, there are many different types of
number formats available. (See table below.) You do not
need to know how to use all of them. You may find that
you only need to use one or a few formats.
Number Format

Description

General

Numbers have no specific formats

Number

Displays numbers with or without decimals

Currency

Formats number to display a £ sign and two decimal places

Accounting

Formats number to display a £ sign and two decimal
places

Date

Choose a date format for your number, e.g. 01/08/00

Time

Choose a time format for your number, e.g. 1:30

Percentage

Multiplies the selected number by 100 and displays %
sign at the end of number

Fraction

Displays selected number as a fraction, e.g. 0.5 to 1/2

Scientific
Text
Special
Custom

Used for scientific data
Used when a number is not part of a calculation, e.g. a
product number such as 17362
For specific numbers like telephone numbers
To create your own number format
To use a number format type, select the style required
from the Category section and make your choices from
the options displayed.

12
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Category
– select the
category of
number style
required.

Sample –
displays the
contents of the
active cell and
shows how the
number will look if
you choose this.

Make your
required choices
from the options
displayed.

Fig. 5 Format cells dialogue box

Formatting a
range of cells

You can apply formats and make changes to a single
cell. However, selecting a range of cells allows you to
make changes to all the selected cells at the same time.
You can use selecting and highlighting when you wish to:

•
•
•
•

apply a number format
make text stand out using bold or underlining
move and copy text to another part of the document
position text on the left, right or centre of the page.

Selecting a range of cells is best used when the selected
cells require the same formats or options. You may
want to make the headings bold and also place them to
the right of their cells so that they line up on the same
side as the numbers. You can select all the cells
required, then apply bold and right align from the
toolbar.
Quite often you may find that you wish to apply a
number format to all numbers in a row, column or even
all the numbers in your spreadsheet. Applying a format
after selecting a range of cells is quicker than working
with cells individually when they require the same
format.

USING MICROSOFT EXCEL SPREADSHEETS. LEARNING FOR WORK Series. © Workbase Training
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Selected/highlighted cells –
drag mouse over required cells to
select the range. You can apply a
format to the whole selection at
the same time.

Formatted cells – currency
format has been applied to all cells
selected without the need to type
the £ sign and decimal places for
each cell in the range.

Fig. 6 Applying format to a selected range of cells
To select text or numbers:
• position the mouse pointer in the first cell you want
to select, keep the left mouse button pressed in
• drag it along the cells until you have highlighted
what you want to change, then release the left
mouse button
• the selection should now be black – note: the first cell
in the highlighted range was the active cell and
although it isn’t highlighted like the other cells, it has
still been included (see fig. 6)
• apply your required format or enhancement,
e.g. bold or a number format
• click anywhere on the spreadsheet to remove the
highlighting from the selection.
If you do not highlight the whole section you require,
you will need to click anywhere on the spreadsheet to
remove the current highlighting on the screen and start
the selecting process again.

14
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Beware! Highlighting can be used for deleting text.
Whilst text is highlighted, any key that is pressed on the
keyboard will delete the selection – if this happens,
click on undo straight away to bring the selection back.
Once you have finished working on a highlighted
section, don’t forget to click anywhere within the page
to turn off the highlighting.

Activity4
You will find the feedback to
this activity on page 31.

Resizing
columns

Changing the appearance of your spreadsheet
1. Select the headings, January, February and March and
make them bold.
2. Select the numbers and apply currency format (£) to
the range.
3. Select the headings and click on the align right icon
on the toolbar.

Whilst typing in a spreadsheet, text and numbers will
overlap into adjacent cells. It is fine to allow this if you
do not mind the overlap. However, columns can be
resized to fit all your text or numbers into a particular
cell or column (see fig. 7).

To resize column: position
the cursor on the right edge of
the column to be resized until
you see the double black arrow
shape of the mouse pointer.
This must be done in the grey
column header area.

Drag the column edge with
the mouse until the column is the
desired size. You can also make
columns smaller.

Fig. 7 Resizing columns

Activity5
You will find the feedback to
this activity on page 31.

Resizing columns in your spreadsheet
Resize column A and enter the following additional text:
Product 1 – Children’s Books
Product 2 – Fiction
Product 3 – Non-fiction

USING MICROSOFT EXCEL SPREADSHEETS. LEARNING FOR WORK Series. © Workbase Training
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Moving and
copying text

Activity6

Inserting or
deleting rows
and columns

Selected text can be moved or copied to another part
of the spreadsheet. Select the cut or copy icons from
the toolbar after highlighting the text to be moved or
copied. Position the cursor where text is to be placed
and click once on Paste icon on the toolbar.

Moving and copying text
Select the word TOTAL from the bottom of column A and
place a copy in cell E2 to the right of March.

You may decide that you wish to add information to
your spreadsheet and you may want to insert an
additional column in your spreadsheet.
To insert a column – place the mouse in the column
where you would like the additional column to be
inserted. From the Insert menu, select Columns. A new
column will be inserted where the mouse was placed.
To delete a column – place the mouse in the column to
be deleted. From the Edit menu, select Delete. The
delete dialogue box will appear. Select Entire column to
delete entire column.

Activity7

16

Insert a new column
1. Insert a column between columns A and B. Make a
cell active in column B and select Insert from the
menu and Insert, columns.

USING MICROSOFT EXCEL SPREADSHEETS. LEARNING FOR WORK Series. © Workbase Training

2. Add the following heading and sales person’s names
in the new column:

There is no feedback to
Activities 6 and 7.

Key
Learning
Points

Product 1
Product 2
Product 3

Sales person
Jane Silby
Bob Moss
Peter Deane

Once you have created your spreadsheet, you can
change its appearance in various ways.
Formatting allows you to alter the spreadsheet,
such as making the headings stand out using bold,
or right aligning text to line up with the numbers.
The width of columns can be resized to match the
length of what you wish to place in a cell. Columns
can also be inserted and deleted within the
spreadsheet.
You can move and copy text and numbers without
having to retype them.
Selecting more than one cell allows you to apply
formatting to all selected cells in one action.

USING MICROSOFT EXCEL SPREADSHEETS. LEARNING FOR WORK Series. © Workbase Training
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Section5

PERFORMING CALCULATIONS
IN A SPREADSHEET

How to perform
calculations in
a spreadsheet

Once you have created your spreadsheet, you may want
to perform calculations on sets of numbers. You may want
to add up a list of numbers and have the answer appear
in the cell you specify. You can carry out calculations
using the normal mathematical operators – addition,
subtraction, multiplication or division. You can create
your own formulas manually or you can use the many
predefined functions that are available. When you carry
out a calculation manually or use the predefined
functions, the result of your calculation will appear in the
cell where the calculation was carried out. A formula
can be simple or very complex depending on what you
are working on. Using formulas and functions saves
time. Depending on how you construct your calculations,
the spreadsheet can automatically be updated with a
new result when a value changes in a cell that has been
included in a calculation.

Functions

Formulas

Functions are predefined formulas that perform
calculations by using specific values, in a particular
order or structure. For example, the SUM or AutoSum
function adds values of ranges of cells.
Formulas are calculations carried out manually and
always start with an equals (=) sign in the cell where
you want the answer to go, e.g. = 1 + 2
When working with formulas, the cell reference rather
than the number contained in the cell is commonly used
when constructing a calculation, e.g. = A1 + A2. When
using cell references, if the number in the cell changes,
the result will be recalculated and the answer/result
updated. Calculations can also include constant values,
meaning a number you type into your formula to be
calculated if there is no reference to a cell, e.g. percentages
= A1 x 20%. Using cell references, the answer will always
be updated when a value changes. If you use a constant
value in a calculation and change a value in a cell, the
result may not be updated. You will need to check and
modify the formula yourself.
Always check your formulas and functions to make sure
they are including the cells or numbers you require. Always
check your formula after making a change to numbers in
your spreadsheet that are part of a calculation.

18
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Using the AutoSum
function

The most frequently used function is SUM, used to add
up a list of specified numbers in a range. The SUM icon
appears on the toolbar.
To add a list of numbers:
1. Highlight the cells in the column or row you wish to
add, including a blank cell where you want the total
to be placed.
2. Click once on the AutoSum icon on the toolbar.

Fig. 8 AutoSum toolbar icon
3. The answer, the total of the selected cells, will be
placed in the last cell that was highlighted.

AutoSum:
Highlight cells
to be added.
Click on
AutoSum to
display the
result/answer.

The AutoSum function automatically writes the formula
that will add up the list of highlighted cells. The formula
is displayed in the formula bar, above the column headers,
when the cell containing the answer is selected/active.
If this number was not a formula, the actual number
would be displayed in the formula bar, e.g. 650.

The
formula bar
shows that
the active cell
is a number
that has been
typed in and
not the result
of a formula.
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The
formula bar
shows that
the active cell
number is a
result of a
formula and
not a number
that has been
typed in.

Fig. 9 Formula/edit bar
The formula displayed begins with an equals sign (=) to
show that a calculation was about to begin. The equals
sign is followed by the word SUM which is the name of
the function that is being used. The cells to be included
in the addition appear within brackets. The first cell and
the last cell in the range to be added are displayed and
separated by a colon (:) to show that there is a range of
cells in between the first and last cell to be included in
the addition.

= SUM (C3 : C5)
Example of
AutoSum formula

= SUM (1st cell : last cell)
AutoSum procedure for adding
lists of numbers – type in cell
references for first and last cell

The AutoSum formula can also be typed manually into
the cell where you want the answer to go, e.g. C6.
Position cursor in the active cell where the answer will
appear and follow the above as a guide to typing your
own formula for adding up a list of numbers manually.
AutoSum is used for adding a list of numbers only. A
wide variety of other formulas and calculations can be
carried out manually or using the predefined functions.

Activity8
20

Use AutoSum to add a list of numbers
1. Use AutoSum to add the numbers for January,
February and March and place the answers in the
TOTAL row.
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You will find the feedback to
this activity on page 31.

Using
mathematical
operators
Order of Calculations

2. Delete the answers given by AutoSum and
manually type the formulas to add the
numbers for January, February and March.

AutoSum
used to
calculate
TOTALS

Mathematical operators can be used to perform
calculations within a spreadsheet. The addition and
subtraction signs are the same as for carrying out
calculations manually using pen and paper. However,
the multiplication and division signs are different.
Multiplication uses the star sign (*) and division uses a
forward slash (/) on the keyboard.
Formulas calculate values in a specific order. Constructing
formulas requires that you follow a few simple rules in
terms of how to lay out a calculation and bear in mind
the order that calculations will be carried out. A formula
begins with an equals (=) sign to inform the spreadsheet
that a calculation is being constructed, followed by the
first cell to be included in the calculation. Use an operator,
then include the next cell to be included. Formulas/
calculations must not include any spaces. A formula can
be simple or complex.
Mathematical Operator
()
*
/
+
-

Description
Brackets
Multiplication
Division
Addition
Subtraction

Fig. 10 Order in which calculations will be carried out
When constructing a formula, any part of the formula
within brackets will be calculated first. After calculating
what is within brackets, multiplication will be calculated
next, followed by division, addition and finally subtraction.
You can control the order of operations by using brackets
to enclose what you wish to be calculated first.
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Formula
6*3+2
6+3*2
6/3+2
2+6/3
6+3+(2*4)

Order of Calculation
6*3 +2
3*2 +6
6/3 +2
6/3 +2
(2*4)+6+3

Answer
20
12
4
4
17

Fig. 11 Example of calculations and their results

Using cell
references

To perform a calculation, the equals sign (=) must appear
first, where you wish to start the calculation. The first
cell to be included in the calculation follows the equals
sign. Then enter the mathematical operator to be
used, e.g. addition, multiplication, subtraction or
division, followed by the last cell to be included in
the formula. Pressing Enter on the keyboard will return
the result of the formula.

= 1st cell +*-/last cell
Order for carrying out
manual calculations

= B3 + C3 + D3
Example of manual
formula

Using cell references in your formula rather than the
numbers that appear in the cell makes your spreadsheet
more efficient and will save you time. If you change a
number within a cell that is included in the formula, the
result will automatically be updated. If you use numbers/
values in your calculation and then change the numbers
in the spreadsheet cell, the result will not change and
you will need to update your formula.

Activity9

The mathematical order of operations
Bearing in mind the mathematical order of operations,
work out the results of the following:
Formula

Order of Calculation

Answer

5*3+(2+4)
(2*4)+3
6-2+1
You will find the feedback to
this activity on page 31.
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4/2*(5-3)
(5*3)/5
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How to use
formulas

Working with formulas using cell references and values.
Cell references are used as much as possible when
carrying out calculations so that if a value in a cell changes,
the result will automatically be updated. However,
occasionally a number/value will be used where the value
does not appear in a cell. For instance, when working with
percentages, the cell reference is used for the main value
and the required percentage is typed into the formula,
e.g. cell reference multiplied by the percentage.

=C6*10%

=C6*110%

calculating a percentage

calculating a percentage
increase

If the value in cell C6 changes, the result will automatically
be recalculated.

Key
Learning
Points

All formulas must start with an equals sign (=).

There must be no spaces when writing
formulas/calculations.
Type cell reference and not the number in the cell
when carrying out calculations where possible.
Changes in the cell referred to will automatically
be recalculated.
You can tell what is a number and what is a
formula only by making the relevant cell active
and looking in the edit/formula bar to see if a
number or formula appears.
Functions are predefined and formulas are
created manually.
AutoSum is used to add a list of numbers.

Brackets, multiplication, division, addition and
subtraction is the order in which calculations
are carried out.
Formulas can be simple or complex.
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Section6

SAVING, CLOSING, OPENING,
AND PRINTING A SPREADSHEET
You can save a spreadsheet that you have created for
future reference. Once you have completed and saved
your spreadsheet, you can close it. The spreadsheet will
be stored in the computer until you wish to open it again.
You can store many spreadsheets on the computer.

Saving a
spreadsheet

When you have entered all your data, the spreadsheet
will not automatically be saved. If you close the spreadsheet without saving it, the spreadsheet will be deleted. If
you wish to use your spreadsheet again, you must save it.
The spreadsheet will be stored in the computer until you
wish to use it again. To save a spreadsheet for the first time:

• click once on File from the menu options
• select Save As from the drop-down list of options. A
dialogue box then appears
• type in the name you want to save the spreadsheet
as. The name will appear in the filename box. Some
computers are set up to save documents in a folder
called My Documents. You can see this name in the
Save In box below. To save into a different folder, click
once on the list triangle to the right of the Save in
box and select a folder
• click on Save.
To choose a
different folder
click once on the
list triangle to
select another area
to store your work.

TIP: When saving spreadsheets for the first time, always
note what is in the Save In box. This will let you know
which folder to find your work in when you wish to
retrieve the file and open it again later.

Always
look at the
Save In: box to
check which
folder your
work will be
saved into,
e.g. My
Documents.

Type in
the file name
for your
spreadsheet.

24

Click
on Save
when
you have
finished.

Fig. 12 Save As dialogue box
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Activity10
You will see the filename at
the top of the screen.
There is no feedback
to this activity.

Closing a
spreadsheet

Activity11

Saving your spreadsheet
1. Save your spreadsheet by clicking on the File menu
option and select Save As from the drop-down list.
2. Name the spreadsheet Sales in the File name box
(see fig. 12).
3. Some computers are set to save documents in a folder
called My Documents – look at the Save in box to see
where your spreadsheet will be saved so that you can
find it later.
4. Click once on Save – observe the title bar now shows
the name you have given to your spreadsheet.

Before you close your spreadsheet, look at the blue
title bar at the top of the screen to make sure you
know what the spreadsheet is called. When you saved
the spreadsheet, you noted the name of the folder the
spreadsheet was saved in. To close your spreadsheet
when you have finished working on it and you have saved
it, click once on File and Close from the menu options.

Close your spreadsheet.
Your document should no longer be on the screen.

There is no further feedback
to this activity.

Opening a
spreadsheet

To Open a spreadsheet that has been saved and closed,
click once on File from the menu option and select
Open. You may need to select the folder where the
spreadsheet was saved. Click once on the triangle for
the Look in box and select the folder where your
work is stored, e.g. My Documents. Click once on the
spreadsheet you wish to open from the list of files and
click on Open.
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Click once on the Look In
list triangle if you need to
select another folder.

Click
once on
Open to
open your
selected
spreadsheet.

Select
your
spreadsheet
from the
list.

Type in the
name of your
spreadsheet if
you know the
exact name.

Activity12

Fig. 13 Open dialogue box

Open the spreadsheet you saved as Sales.
Your spreadsheet should now be on the screen.

There is no further feedback
to this activity.

Printing a
spreadsheet

There are different page layout options you can choose
before printing spreadsheets. You can change the
layout of the page and choose whether or not to have
lines around your spreadsheet before printing.
You can print your spreadsheet by selecting File and
Print from the menu options. Check that the number 1
is in the number of copies box and click on OK.
Changing the page layout of the spreadsheet for printing
You can change the layout of a spreadsheet page from
portrait (longways) to landscape (widthways) to fit
more of a spreadsheet on to one page. Select Page
Setup from the File menu. Click on landscape to change
the page layout.

26
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Page layout –
click on round button
to change the
spreadsheet layout
to landscape
if required.

Fig. 14 Page Setup dialogue box – displaying
page layout options

Printing with
gridlines and
row headings

You can choose whether to print your spreadsheet
with gridlines or without. It is a matter of preference
how you choose to view your spreadsheet. You can
also choose to print the grey shaded row and column
headings too. Printing with or without gridlines can be
selected from the Page Setup under the File menu.
Select the Sheet tab to make changes to the
spreadsheet layout.

Sheet –
select the sheet
tab to apply
gridlines and
headings.

Gridlines –
click a 4 in the
box to print
lines around
your spreadsheet – remove
the tick if you
don’t want lines
(see A and B
Spreadsheet
layout printing
options on
page 28).

Fig. 15 Page Setup dialogue box –
displaying spreadsheet gridline options

Row/
column headings
– click a 4 in the
box to show
headings on your
spreadsheet –
remove the tick if
you don’t want
headings (see C
Spreadsheet
layout printing
options on
page 28).
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Spreadsheet page layout printing options
A Spreadsheet without gridlines

B Spreadsheet with gridlines

C Spreadsheet with row and column headings displayed

Activity13

Print one copy of your spreadsheet with gridlines and
one without.
You will have two hard copies.

There is no further feedback
to this activity.

28
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Key
Learning
Points

You can save your spreadsheet for future
reference. Click once on File and then Save.
Before you close a spreadsheet, always make sure
you know the name of the spreadsheet and the
folder it will be saved in.
To close a spreadsheet, select File from the menu
options and Close.
To open a new spreadsheet, click once on the New
spreadsheet icon on the toolbar or choose File and
New from the menu options.
To open an existing spreadsheet, click once on File
and then Open from the menu options. Select the
folder where the file is saved and then select the
file from the list.
You can choose how to lay out your spreadsheet
page before printing. You can print your spreadsheet
with or without gridlines, with or without row and
column headings and you can choose to print your
spreadsheet portrait (longways) or landscape
(widthways).
To print your spreadsheet, select File and Print
from the menu options.
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FeedBack

toActivities

FEEDBACK TO ACTIVITY 1
1. (b) a large grid for working with numbers and words
2. Budgets
Sales information
Expenses list.
FEEDBACK TO ACTIVITY 2
1.
A
1

B

C

D

E

F

A1

2
3
4
5

B5

6
7
8
9

E9

10
11
12

F12

2. (b) The active cell is where anything typed will appear.

FEEDBACK TO ACTIVITY 3
2.

30

USING MICROSOFT EXCEL SPREADSHEETS. LEARNING FOR WORK Series. © Workbase Training

FEEDBACK TO ACTIVITY 4

3.
January,
February and
March are right
aligned.

1.
January, February
and March are bold.
2.
Currency
format applied
to range of
numbers.

FEEDBACK TO ACTIVITY 5

1.
Column A
widened to
accept the
additional
data.

Double click on
cell to edit data.

FEEDBACK TO ACTIVITY 8
2.
Formula for
adding
list of
numbers
manually.

FEEDBACK TO ACTIVITY 9
Formula

Order of Calucation

Answer

5*3+(2+4)

(2+4)+5*3
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(2*4)+3

(2*4)+3

11

6-2+1

6-2+1

5

4/2*(5-3)

(5-3) *4/2

4

(5*3)/5

(5*3)/5

3
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Glossary

of terms used

32

Active cell

Cell with dark box around it where
anything typed will be entered.

Alignment

How text is lined up within a cell,
e.g. left, right or centred.

AutoSum

Used to automatically provide a total
for a selected list of numbers.

Backspace

Removes letters that appear on the
left-hand side of the flashing cursor.

Bold

Making selected text darker than the
rest of the text so that it stands out.

Calculation

Starts with = and uses cell references
and mathematical operators.

Cancel

Click on cancel if a dialogue box
appears that you do not wish to use.

Cell

One boxed area on a spreadsheet grid.

Cell reference

The column letter and row number
for a cell.

Centre

Text is placed in the middle of a line
between the left and right edges of
a cell.

Column

Headed by a letter along the top of a
spreadsheet.

Close

Remove a spreadsheet from the
screen display area by closing it.

Copy

Duplicate text by highlighting the
text, clicking on copy icon, moving
the cursor where text is to be copied
to and choosing the paste icon to
place the text where the cursor is
positioned.

Cursor

Flashing symbol within a cell where
typing will commence.

USING MICROSOFT EXCEL SPREADSHEETS. LEARNING FOR WORK Series. © Workbase Training

Cut

Move text from one place in a
document to another by highlighting
the text, clicking on the cut icon,
positioning the cursor where text is
to be placed and finally choosing the
paste icon to place the text where
the cursor is positioned.

Delete

Remove letters or words by using the
backspace or delete keys.

Dialogue box

A box that appears when some toolbar icons or menu options are used.

Document

The blank grid page that appears on
the spreadsheet computer screen for
you to type text into; sometimes also
called a page or file.

Edit

Make changes to a typed spreadsheet.
You can insert and delete letters,
words or numbers and copy or
move text to another part of the
spreadsheet.

Enter

The enter key on the keyboard moves
the cursor to the next active cell.

File

See Document.

Filename

The name given to a spreadsheet that
you wish to save. You will look for the
filename when you wish to go back
and find the document later.

Folder

Storage area for a document. Usually
yellow and is the computerised
version of a paper folder that
documents are stored in

Formatting

Changing the look of a spreadsheet,
e.g. making some text stand out.

Formula

Calculation.

Function

Predefined calculation, e.g. SUM.

Grid

Worksheet area in a spreadsheet set
up as a series of boxes on a page.
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Gridlines

Lines around each cell.

Highlighting

See Selecting.

Icons

Picture symbols used to activate
different functions, e.g. Print.

Insert

Add numbers or words anywhere in a
spreadsheet by making the cell active
where the insertion is to appear.

Layout

How a spreadsheet is presented on a
page, e.g. spacing used, centring.

Mathematical
operators

Brackets, multiplication, division,
subtraction, addition.

Menu options

Grey bar near the top of the screen
that starts with the word File and
ends with Help. Clicking on any word
brings down a list of different
functions that can be used.

OK

After choosing options in a dialogue
box, click on OK to accept the options.

Open

Retrieve a file stored in the computer
and display it on the screen.

Options

Alternative word for functions,
meaning things that you can do.

Page

Alternative word for a worksheet.

Paste

To place text that has been cut or
copied. Ensure the cursor is in the
position where text is to be placed
before clicking on the paste icon.

Print

Produce a copy of a document on a
sheet of paper (hard copy).

Row

Headed by a number on the left of a
spreadsheet.

Save

To store a document on the computer
for future reference.
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Scroll bar

Grey bar with a black triangle at each
end that allows you to move up and
down or left to right to see the parts
of the page that are hidden from view.

Selecting

Highlighting by dragging over a selection of words or letters until they are
all black. Selecting is used when you
wish to carry out a
function on the selected area only.

Spell check

Spreadsheet packages contain a
dictionary that checks words as you
type them. Right clicking on a word
underlined in red will provide a list of
alternative spellings. You can left click
on a word from the list to use that
word instead.

Spreadsheet

Large grid for entering numbers and
performing calculations on a computer.

Sum

Function for adding a list of numbers.

Text
enhancements

Making text stand out by using bold,
italic and underline.

Toolbar

A row of picture symbols along a grey
bar that represent different functions
that are available for your use.

Toolbar icons

Each picture on a toolbar is called an
icon.

Undo

Used to cancel the last action – click
on undo immediately after you make a
mistake to cancel the last action.

Value

Number.

Worksheet

One page in a spreadsheet.
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Do you:
Want to know what spreadsheets are and how they
can be used?
Feel nervous when you are asked to produce
information on a spreadsheet?
Want to know how to create a spreadsheet and make
corrections?
Wish to learn how to present the information on
spreadsheets in different ways?
Want to know what formula you would use to make
calculations in a spreadsheet?
If you answered ‘Yes’ to one or more of these
questions, you will find that the descriptions and
activities in this booklet will help you with the
following:

• understand the common words used
• create and correct a spreadsheet
• change the layout of spreadsheets to improve
appearance and presentation
• use formulae to perform calculations.
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